
Chapter 21

Drawing and Viewing
3D Objects

After completing this chapter, you will be able to:
• Understand the need of changing the viewpoint.
• Understand various 3D coordinate systems.
• Setting thickness and elevation for the new objects.
• Use the HIDE command.
• Understand regions and how to create them.
• Create 3D objects.
• Dynamically view 3D objects using the DVIEW command.
• Create shaded models.
• Analyze regions using the MASSPROP command.
• Modify the properties of the hidden lines.

Learning Objectives
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Menu: View > 3D Views > Viewpoint Presets
Command: DDVPOINT

Figure 21-2  Figure showing the 3D model
after changing the viewpoint

Figure 21-1  Figure showing a rectangle in the
Plan view

CHANGING THE VIEWPOINT TO VIEW 3D MODELS
Until now, you have drawn only the 2D entities in the XY plane and in the plan view. But in the
plan view, it is very difficult to find out whether the object displayed is a 2D entity or a 3D
model. For example, see Figure 21-1. In this view, it appears as though the object displayed is a
rectangle. The reason for this is that by default you view the objects in the plan view from the
direction of the positive Z axis. This is a very confusing situation that has to be avoided. This
situation can be avoided if the object is viewed from a direction that also displays the Z axis. In
order to do that, you need to change the viewpoint so that the object is displayed in the space
with all three axes as shown in Figure 21-2. In this view you can also see the Z axis of the model
along with the X and the Y axes and so it is clear that the original object is not a rectangle but is
a 3D model. The viewpoint can be changed by the DDVPOINT command, the VPOINT
command or using the View toolbar.

Tip
Bear in mind that changing the viewpoint does not affect the dimensions or the location of the
model. When you change the viewpoint, the model is not moved from its original location.
Changing the viewpoint only changes the direction from which you are viewing the model.

Changing the Viewpoint Using the Viewpoint Presets Dialog
Box

The DDVPOINT command is used to set the viewpoint to view the 3D models. The viewpoint
in this command is set with respect to the angle in the XY plane and the angle from the XY
plane. Figure 21-3 shows different view direction parameters.

When you invoke this command, the Viewpoint Presets dialog box will be displayed as shown
in Figure 21-4.



Drawing and Viewing 3D Objects    21-3

©
 C

A
D

C
IM

 T
ec

hn
ol

og
ie

s,
 U

S
A

. F
or

 e
ng

in
ee

ri
ng

 s
er

vi
ce

s,
 c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

Viewpoint Presets Dialog Box Options
Absolute to WCS. This radio button is selected to set the viewpoint with respect to the world
coordinate system.

Relative to UCS. This radio button is selected to set the viewpoint with respect to the current
user coordinate system.

Note
The WCS and the UCS were discussed in Chapter 20, The User Coordinate System.

Figure 21-3  Figure showing view direction parameters

Figure 21-4 The Viewpoint Presets dialog box
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Figure 21-6  Figure showing the image tile for
selecting the angle from the XY plane

From: X Axis. This edit box is used to specify the angle in the XY plane from the X axis. You can
directly enter the required angle in this edit box or you can select the desired angle from the
image tile (Figure 21-5). There are two arms in this image tile and by default, they are placed one
over the other. The gray arm displays the current viewing angle and the black one displays the
new viewing angle. When you select a new angle from the image tile, the new angle is automatically
displayed in the X Axis edit box. This value can vary between 0 and 359.9.

XY Plane. This edit box is used to specify the
angle from the XY plane. You can directly enter
the desired angle in this edit box, or can select
the angle from the image tile as shown in
Figure 21-6. This value can vary from -90 to +90.

Set to Plan View. This button is chosen to set
the viewpoint to the plan view of the WCS or the
UCS. If the Absolute to WCS radio button is
selected, the viewpoint is set to the plan view of
the WCS and if the Relative to UCS radio button
is selected, the viewpoint is set to the plan view of the current UCS.

Figure 21-7 and Figure 21-8 shows a 3D model from different viewing angles. If you set a
negative angle from the XY plane, then the Z axis will be displayed in the dotted line, see
Figure 21-9 and Figure 21-10.

Note
In case of confusion in the direction of the X, Y, and Z axes, use the right-hand rule.

Changing the Viewpoint Using the Command Line

The VPOINT command is also used to set the viewpoint for viewing the 3D models. This
command allows the user to specify a point in the 3D space that will act as the viewpoint. The
prompt sequence that will follow when you invoke this command is given next.

Figure 21-5  Image tile for selecting the angle
in the XY plane

Menu: View > 3D Views
Command: VPOINT
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Current view direction:  VIEWDIR=0.0000,0.0000,1.0000
Specify a view point or [Rotate] <display compass and tripod>:

Specifying a Viewpoint
This is the default option and is used to set a viewpoint by specifying the location of the
viewpoint using the X, Y, and Z coordinates of that particular point. AutoCAD LT follows a
conventions of the sides of the 3D model for specifying the viewpoint. The convention states
that if the UCS is at the World position (default position), then

1. The side at the positive X axis direction will be taken as the right side of the model.
2. The side at the negative X axis direction will be taken as the left side of the model.
3. The side at the negative Y axis direction will be taken as the front side of the model.
4. The side at the positive Y axis direction will be taken as the back side of the model.
5. The side at the positive Z axis direction will be taken as the top side of the model.

Figure 21-7  Viewing the 3D model with the
angle in the XY plane as 225 and angle from

Figure 21-8  Viewing the 3D model with the angle
in the XY plane as 145 and angle from the XY

Figure 21-9  Viewing the 3D model with the
angle in the XY plane as 315 and angle from
the XY plane as -25

Figure 21-10  Viewing the 3D model with the
angle in the XY plane as 225 and angle from the
XY plane as -25
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Figure 21-12  Viewing the model with the
viewpoint 1,1,1

Figure 21-11  Viewing the model with the
viewpoint -1,-1,1

6. The side at the negative Z axis direction will be taken as the bottom side of the model.

Some of the standard viewpoint coordinates and the view they display are shown below.

       Vpoint Value      View Displayed
1,0,0 Right side view
-1,0,0 Left side view
0,1,0 Back view
0,-1,0 Front view
0,0,1 Top view
0,0,-1 Bottom view
1,1,1 Right, Back, Top view
-1,1,1 Left, Back, Top view
1,-1,1 Right, Front, Top view
-1,-1,1 Left, Front, Top view
1,1,-1 Right, Back, Bottom view
-1,1,-1 Left, Back, Bottom view
1,-1,-1 Right, Front, Bottom view
-1,-1,-1 Left, Front, Bottom view

Figures 21-11 through 21-14 show the 3D model from different viewpoints.
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Compass and Tripod
When you press ENTER at the Specify a view point or [Rotate] <display compass and tripod>
prompt, a compass and an axis tripod is displayed, as shown in Figure 21-15.

You can directly set the viewpoint using this compass. A crosshair appears on the compass and
you can pick any point on it to specify the viewpoint. The compass consists of two circles, a
smaller circle and a bigger circle. Both these circles are divided into four quadrants: first,
second, third, and fourth. The resultant view will depend upon the quadrant and the circle on
which you pick the point. In the first quadrant, both the X and the Y axes are positive; in the
second quadrant, the X axis is negative and the Y axis is positive; in third quadrant both the X
and Y axes are negative; and in the fourth quadrant, the X axis is positive and the Y axis is
negative. Now, if you pick the point inside the inner circle, it will be in the positive Z axis

Figure 21-14  Viewing the model with the
viewpoint -1,1,1

Figure 21-13  Viewing the model with the
viewpoint 1,-1,1

Figure 21-15  The axis tripod and the compass
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direction and if you pick the point outside the inner circle and inside the outer circle, it will be
in the negative Z axis direction. Therefore, if the previously mentioned statements are added,
the following can be concluded.

1. If you pick a point inside the smaller circle
in the first quadrant, the resultant view
will be the Right, Back, Top view. If you
pick a point out side the smaller circle
and inside the bigger circle in this
quadrant, the resultant view will be the
Right, Back, Bottom view (Figure 21-16).

2. If you pick a point inside the smaller circle
in the second quadrant, the resultant view
will be the Left, Back, Top view. If you
pick a point outside the smaller circle and
inside the bigger circle in this quadrant,
the resultant view will be the Left, Back,
Bottom view (Figure 21-16).

3. If you pick a point inside the smaller circle in the third quadrant, the resultant view will be
the Left, Front, Top view. If you pick a point outside the smaller circle and inside the bigger
circle in this quadrant, the resultant view will be the Left, Front, Bottom view (Figure 21-16).

4. If you pick a point inside the smaller circle in the fourth quadrant, the resultant view will be
the Right, Front, Top view. If you pick a point outside the smaller circle and inside the
bigger circle in this quadrant, the resultant view will be the Right, Front, Bottom view
(Figure 21-16).

Rotate
This option is similar to setting the viewpoint in the Viewpoint Presets dialog box displayed by
invoking the DDVPOINT command. When you select this option, you will be prompted to
specify the angle in the XY plane and the angle from the XY plane. The angle in the XY plane
will be taken from the X axis.

Changing the Viewpoint Using the View Toolbar
Apart from the DDVPOINT and the VPOINT commands, you can also set the viewpoint using
the View toolbar shown in Figure 21-17.

This toolbar consists of six preset orthographic views: Top View, Bottom View, Left View, Right View,
Front View, and Back View. Apart from these orthographic views, this toolbar also has four
preset isometric views: Southwest Isometric View, Southeast Isometric View,
Northeast Isometric View, and Northwest Isometric View.

Figure 21-16  Figures showing the directions for
the compass
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Tip
When you choose any of the preset orthographic views from the View toolbar, the UCS is also
aligned to that view.

3D COORDINATE SYSTEMS
Similar to the 2D coordinate systems, there are two main types of coordinate systems. They are
as follows.

Absolute Coordinate System
This type of coordinate system is similar to the 2D absolute coordinate system in which the
coordinates of the point are calculated from the origin (0,0). The only difference is that here
along with the X and Y coordinates, the Z coordinates are also included. For example, if you
want to draw a line in 3D space starting from the origin to a point say 10,6,6, the procedure to
be followed is:

Command: LINE
Specify first point: 0,0,0
Specify next point or [Undo]: 10,6,6
Specify next point or [Undo]: �

Figure 21-18 shows a figure drawn using the absolute coordinate systems.

Figure 21-17 The View toolbar
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In this example, you will draw the 3D wireframe model shown in Figure 21-19.

1. Choose the Line button from the Draw toolbar. The prompt sequence is as follows.

Specify first point: 2,2,0
Specify next point or [Undo]: 8,2,0
Specify next point or [Undo]: 8,6,0
Specify next point or [Close/Undo]: 2,6,0
Specify next point or [Close/Undo]: C

Example 1

Figure 21-19  3D model for Example 1

Figure 21-18  Drawing a line from origin to 10,6,6
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2. Choose 3D Views > Viewpoint Presets from the View menu to display the Viewpoint
Presets dialog box.

3. Set the value of the X Axis edit box to 225.

4. Set the value of the XY Plane edit box to 38, see Figure 21-20. Choose OK.
5. Choose the Line button from the Draw toolbar. The prompt sequence is as follows.

Specify first point: 2,2,0

Specify next point or [Undo]: 2,2,2
Specify next point or [Undo]: 2,4,2
Specify next point or [Close/Undo]: 8,4,2
Specify next point or [Close/Undo]: 8,2,2
Specify next point or [Close/Undo]: 2,2,2
Specify next point or [Close/Undo]: �

6. Choose the Line button from the Draw toolbar. The prompt sequence is as follows.

Specify first point: 2,4,2
Specify next point or [Undo]: 2,4,4
Specify next point or [Undo]: 2,6,4
Specify next point or [Close/Undo]: 2,6,0
Specify next point or [Close/Undo]: �

Figure 21-20 The  Viewpoint Presets dialog box
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7. Choose 3D Views > Viewpoint Presets from the View menu to display the Viewpoint
Presets dialog box.

8. Set the value of the X Axis edit box to 335.

9. Set the value of the XY Plane edit box to 35. Choose OK.

10. Choose the Line button from the Draw toolbar. The prompt sequence is as follows.

Specify first point: 8,2,0
Specify next point or [Undo]: 8,2,2
Specify next point or [Undo]: �

11. Choose the Line button from the Draw toolbar. The prompt sequence is as follows.

Specify first point: 8,4,2
Specify next point or [Undo]: 8,4,4
Specify next point or [Undo]: 8,6,4
Specify next point or [Close/Undo]: 8,6,0
Specify next point or [Close/Undo]: �

12. Choose the Line button from the Draw toolbar. The prompt sequence is as follows.

Specify first point: 8,6,4
Specify next point or [Undo]: 2,6,4
Specify next point or [Undo]: �

13. Choose the Line button from the Draw toolbar. The prompt sequence is as follows.

Specify first point: 8,4,4
Specify next point or [Undo]: 2,4,4
Specify next point or [Undo]: �

14. Enter VPOINT at the Command prompt. The prompt sequence is as follows.

Current view direction:  VIEWDIR=0.7424,-0.3462,0.5736
Specify a view point or [Rotate] <display compass and tripod>: -1,-1,1

15. The final model should look similar to the one shown in Figure 21-21.
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Relative Coordinate System
In the 3D, you are provided with three types of relative coordinate systems. They are as follows.

Relative Rectangular Coordinate System
This coordinate system is similar to the relative rectangular coordinate system, except that in 3D
you have to enter the Z coordinate also along with the X and the Y coordinates. The syntax of the
relative rectangular system for the 3D is @X coordinate,Y coordinate, Z coordinate.

Relative Cylindrical Coordinate System
In this type of coordinate system, you are allowed to locate the point by specifying its distance
from the reference point, the angle in the XY plane, and its distance from the XY plane. The
syntax of the relative cylindrical coordinate system is @Distance from the reference point in
the XY plane<Angle in the XY plane from the X axis, Distance from the XY plane along the
Z axis. Figure 21-22 shows various components of the relative cylindrical coordinate system.

Relative Spherical Coordinate System
In this type of coordinate system you are allowed to locate the point by specifying the distance of
the point from the reference point, the angle in the XY plane, and the angle from the XY plane.
The syntax of the relative spherical coordinate system is @Length of the line from the reference
point<Angle in the XY plane from the X axis<Angle from the XY plane. Figure 21-23 shows
various components involved in the relative spherical coordinate system.

Tip
The major difference between the relative cylindrical and relative spherical coordinate system
is that in the relative cylindrical coordinate system, the distance you specify is the distance from
the reference point in the XY plane, whereas in the relative spherical coordinate system, the
distance you specify is the total length of the line in the 3D space.

Figure 21-21  Final 3D model for Example 1
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In this example, you will draw the 3D wireframe model shown in Figure 21-24. The dimensions
of the model are given in Figure 21-25 and Figure 21-26.

1. Choose the SW Isometric View button from the View toolbar to shift to the southwest isometric
view.

2. As the start point of the model is not given, therefore, you can start the model from any point.

Example 2

Figure 21-22  Figure showing various components of the relative
cylindrical coordinate system

Figure 21-23  Figure showing various components of the relative
spherical coordinate system
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Choose the Line button from the Draw toolbar to invoke the LINE command. The prompt
sequence is as follows.

Specify first point: 4,2,0
Specify next point or [Undo]: @0,0,2
Specify next point or [Undo]: @3,0,0
Specify next point or [Close/Undo]: @0,0,2
Specify next point or [Close/Undo]: @3,0,0
Specify next point or [Close/Undo]: @2<0<315
Specify next point or [Close/Undo]: @2<0<45
Specify next point or [Close/Undo]: @3,0,0
Specify next point or [Close/Undo]: @0,0,-2
Specify next point or [Close/Undo]: @3,0,0
Specify next point or [Close/Undo]: @0,0,-2
Specify next point or [Close/Undo]: C

Figure 21-24  Wireframe model for Example 2

Figure 21-25  Front view of the model Figure 21-26  Side view of the model
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3. Choose the Line button from the Draw toolbar. The prompt sequence is as follows.

Specify first point:  4,2,0
Specify next point or [Undo]: @0,8,0
Specify next point or [Undo]: @0,0,2
Specify next point or [Close/Undo]: @3,0,0
Specify next point or [Close/Undo]: @0,0,2
Specify next point or [Close/Undo]: @3,0,0
Specify next point or [Close/Undo]: @2<0<315
Specify next point or [Close/Undo]: @2<0<45
Specify next point or [Close/Undo]: @3,0,0
Specify next point or [Close/Undo]: @0,0,-2
Specify next point or [Close/Undo]: @3,0,0
Specify next point or [Close/Undo]: @0,0,-2
Specify next point or [Close/Undo]: @0,-8,0
Specify next point or [Close/Undo]: �

4. Complete the model by joining the remaining edges using the LINE command.

5. The final 3D model should look similar to the one shown in Figure 21-27.

Figure 21-27  Final 3D model for Example 2
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In this exercise, you will draw the 3D wireframe model shown in Figure 21-28. The dimensions
for the model are given in the figure itself. You can start the model from any point.

TRIM, EXTEND, AND FILLET COMMANDS IN 3D
As discussed earlier, you can use various options of these commands in 3D space. You can also
use the PROJMODE and EDGEMODE variables. The PROJMODE variable sets the projection
mode for trimming and extending. A value of 0 implies True 3D mode, that is, no projection.
In this case, the objects must intersect in 3D space to trim or extend them. It is similar to using
the None option of the Project option of the EXTEND and TRIM commands. A value of 1
projects onto the XY plane of the current UCS and is similar to using the UCS option of the
Project option of the TRIM or EXTEND commands. A value of 2 projects onto the current
view plane and is like using the View option of the Project option of the TRIM or EXTEND
commands. The value of the EDGEMODE system variable controls how the cutting or trimming
boundaries are decided. A value of 0 considers the selected edge with no extension. You can also
use the No Extend option of the Edge option of the TRIM or EXTEND commands. A value of
1 considers an imaginary extension of the selected edge. This is similar to using the Extend
option of the Edge option of the TRIM or EXTEND commands.

You can fillet coplanar objects whose extrusion directions are not parallel to the z axis of the
current UCS by using the FILLET command. The fillet arc exists on the same plane and has
the same extrusion direction as the coplanar objects. If the coplanar objects to be filleted exist in
opposite directions, the fillet arc will be on the same plane but will be inclined toward the
positive Z axis.

Figure 21-28  Wireframe model for Exercise 1

Exercise 1 General
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SETTING THICKNESS AND ELEVATION FOR  NEW
OBJECTS
You can create the objects with a preset elevation or thickness using the ELEV command. This
command is discussed next.

ELEV Command

This command is a transparent command and is used to set the elevation and thickness for new
objects. The prompt sequence that follows when you invoke this command is given next.

Specify new default elevation <0.0000>:
Specify new default thickness <0.0000>:

Elevation
This option is used to specify the elevation value for new objects. Setting the elevation is nothing
but moving the working plane from its default position. By default, the working plane is on the
world XY plane. You can move this working plane using the Elevation option of the ELEV
command. However, remember that the working plane can be moved only along the Z axis
(Figure 21-29). The default elevation value is 0.0 and you can set any positive or negative value
for elevation. All the objects that will be drawn hereafter will be with the specified elevation. The
Elevation option sets the elevation only for the new objects and the existing objects are not
modified using this option.

Thickness
This option is used to specify the thickness values for the new objects. It is another method of
creating the surface models. Specifying the thickness creates the extruded surfaces. The thickness
is always taken along the Z axis direction (Figure 21-30). The 3D faces will be automatically
applied on the vertical faces of the objects drawn with a thickness. The Thickness option sets
the thickness only for the new objects and the existing objects are not modified using this
option.

Command: ELEV

Figure 21-30  Object drawn with thicknessFigure 21-29  Object drawn with elevation
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Figure 21-31 shows a point, line, ellipse, circle, and a polygon drawn with a thickness and
Figure 21-32 shows text with and without thickness. Remember that to write a text with thickness,
first write simple text and then change its thickness using any of the commands that modify the
properties.

Tip
The elevation value will be reset to 0.0 when you change the viewpoint using the preset
orthographic views in the View toolbar.

The rectangles drawn using the RECTANG command do not consider the thickness value set
using the ELEV command. To draw a rectangle with thickness, use the Thickness option of
the RECTANG command.

To draw an ellipse with thickness, first set the value of the PELLIPSE system variable to 1.

SUPPRESSING THE HIDDEN EDGES

In the 3D objects drawn with some thickness, some of the lines lie behind other lines or objects.
These lines are called hidden lines or hidden edges. Sometimes, you may want to suppress the
hidden edges in the model to enhance the clarity of the objects. You can suppress these hidden
edges using the HIDE command. This command is used to suppress the hidden lines in the 3D
model. When you invoke this command, all the objects on the screen are regenerated and the
3D models are displayed with the hidden edges suppressed. The hidden lines are again included
in the drawing when the next regeneration takes place. Note that the circles, solids and wide
polylines are considered to be solids if they are drawn with thickness. In this case the bottom
and top faces are also considered. Figure 21-33 shows the objects with thickness displaying the
hidden edges and Figure 21-34 shows the objects with thickness and the hidden edges suppressed.

Figure 21-31  A point, line, ellipse, circle, and a
polygon drawn with a thickness of 5 units

Figure 21-32  Text with and without thickness

Menu: View > Hide
Command: HIDE
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You can define the color and linetype of the hidden lines using the OBSCUREDCOLOR and
the OBSCUREDLTYPE variables. If you specify any value for these variables, the hidden lines
will not be suppressed when you invoke the HIDE command. Instead, these lines will be displayed
using the color and linetype specified in their respective variables. You will learn more about
changing the color and linetype of the hidden lines later in this chapter.

Tip
The HIDE command considers Circles, Solids, Polylines with width, and Regions as opaque
surfaces that will hide objects.

Draw the objects shown in Figure 21-35 and Figure 21-36 using the Elevation and Thickness
options of the ELEV command. Hide the hidden lines and then view the objects using
different viewpoints.

Figure 21-34  Objects after suppressing the hidden
edges

Figure 21-33  Objects before suppressing the
hidden edges

Exercise 2 General

Figure 21-36  Drawing for Exercise 2Figure 21-35  Drawing for Exercise 2
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CREATING 3D POLYLINES

The 3DPOLY command is used to draw straight polylines in a 2D plane or in 3D space. This
command is similar to the PLINE command except that using this command you can draw the
polylines in the plane other then the XY plane also. However, this command does not provide
the Width or the Arc option and therefore, you can not create a 3D polyline with width or arc.
The Close and the Undo options of this command are similar to those of the PLINE command.

Tip
You can fit a spline curve about the 3D polyline using the PEDIT command. Use the Spline
curve option to fit the spline curve and the Decurve option to remove the spline curve.

CREATING REGIONS

The REGION command is used to create regions from the selected loops or closed
entities. Regions are the 2D entities with properties of the 3D solids. You can apply
the Boolean operation on the regions and you can also calculate the mass properties of

the regions. Bear in mind that the 2D entity you want to convert into a region should be a closed
loop. Once you have created regions, the original object is deleted automatically. However, if the
value of the DELOBJ system variable is set to 0, the original object is retained. The valid
selection set for creating the regions are closed polylines, lines, arcs, splines, circles, or ellipses.
The current color, layer, linetype, and lineweight will be applied to the regions.

CREATING COMPLEX REGIONS BY APPLYING BOOLEAN
OPERATIONS
You can create complex regions by applying the Boolean operations on them. The various Boolean
operations that can be performed are union, subtract, and intersect. The commands used to apply
these Boolean operations are discussed next.

Combining Regions

The UNION command is used to apply the union Boolean operation on the selected set of
regions. You can create a composite region by combining them using this command. You can
combine any number of regions. When you invoke this command, you will be prompted to select
the regions to be added (Figure 21-37). Figure 21-38 shows the complex region created by
uniting the two regions shown in Figure 21-37.

Toolbar: Draw > Region
Menu: Draw > Region
Command: REGION

Menu: Modify > Region > Union
Command: UNION

Menu: Draw > 3D Polyline
Command: 3DPOLY
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Subtracting Regions

The SUBTRACT command is used to create a composite region by removing the material
common to the selected set of regions. When you invoke this command, you will be prompted to
select the set of regions to subtract from. Once you have selected the set of regions to subtract
from, you will be prompted to select the regions to subtract. The material common to the first
selection set and the second selection set is removed from the first selection set. The resultant
object will be a single composite region, see Figure 21-39 and Figure 21-40.

Intersecting Regions

Figure 21-38  Single region after unionFigure 21-37  Two different regions before union

Menu: Modify > Region > Intersect
Command: INTERSECT

Menu: Modify > Region > Subtract
Command: SUBTRACT

Figure 21-40  Single region after subtractingFigure 21-39  Two different regions before
subtracting
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The INTERSECT command is used to create a composite region by retaining the material
common to the selected set of regions. When you invoke this command, you will be prompted to
select the regions be to intersected. The material common to all the selected regions will be
retained to create a new composite solid (Figure 21-41 and Figure 21-42).

Draw the objects shown in Figure 21-43 by creating different regions and then bringing them
together. Assume the dimensions.

DYNAMIC VIEWING OF 3D OBJECTS
With the DVIEW command, you can create a parallel projection or a perspective view of objects
on the screen. Basically, DVIEW is an improvement over the VPOINT command in that the
DVIEW command allows you to visually maneuver around 3D objects to obtain different views.

Exercise 3 General

Figure 21-43  Drawing for Exercise 3

Figure 21-42  Single region after intersectingFigure 21-41  Two different regions before
intersecting
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As just mentioned, the DVIEW command offers you a choice between parallel viewing and
perspective viewing. The difference between the two is that in parallel view, parallel lines in the
3D object remain parallel, whereas in perspective view, parallel lines meet at a vanishing point.
These definitions suggest that with the VPOINT command, only parallel viewing is possible.
When the perspective view is current, ZOOM, PAN, ‘ZOOM, ‘PAN, DSVIEWER commands,
and scroll bars are not available. The DVIEW command uses the camera and target concept to
visualize an object from any desired position in 3D space. The position from which you want to
view the object (the viewer’s eye) is the camera, and the focus point is the target. The line formed
between these two points is the line of sight, also known as the viewing direction. To get different
viewing directions, you can move the camera or target or both. Once you have the required
viewing direction, you can change the distance between the camera and the target by moving the
camera along the line of sight. The field of view can be changed by attaching a wide-angle lens
or a telephoto lens to the camera. You can pan or twist (rotate) the image. The hidden lines in
the object being viewed can be suppressed. You can clip those portions of the model that you do
not want to see. All these options of the DVIEW command demonstrate how useful this command
is. The ‘ZOOM, DSVIEWER, PAN commands and Scroll bars are not available in the DVIEW
command.

Command: DVIEW �
Select objects or <use DVIEWBLOCK>: Select the objects you want to view dynamically or
press ENTER to use the DVIEWBLOCK.
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: Specify a point
or enter an option.

The point you specify is the start point for dragging. As you move the cursor, the viewing
direction changes. The Command prompt is given next.

Enter direction and magnitude angles: Enter angles between 0 to 360-degree or specify on screen.

The direction angle determines the front of the view and the magnitude angle determines the
how far the view is. The different DVIEW command options are discussed next.

CAmera Option
With the CAmera option, you can rotate the camera about the target point. To invoke the
CAmera option, enter CA at the Enter option [CAmera/TArget/Distance/POints/PAn/Zoom/
TWist/CLip/Hide/Off/Undo] prompt. Once you have invoked this option, the drawing is
still, but you can maneuver the camera up and down (above or below the target) or you can
move it left or right (clockwise or counterclockwise around the target). Remember that when
you are moving the camera, the target is stationary, and that when you are moving the target,
the camera is stationary. The next prompt AutoCAD LT displays is given next.

Specify camera location, or enter angle from XY plane, or [Toggle (angle in)] <current>:

By default, this prompt asks you for the angle from the XY plane of the camera to the current
UCS. This is nothing but the vertical (up or down) movement of the camera about the target.
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There are two ways to specify the angle.

1. You can specify the angle of rotation by moving the graphics cursor in the graphics area
until you attain the desired rotation and then choosing the pick button of your pointing
device. You will notice that as you move the cursor in the graphics area, the angle of
rotation is continuously displayed in the status bar. Also, as you move the cursor, the
object also moves dynamically. If you give a horizontal movement to the camera at the
Specify camera location, or enter angle from XY plane, or [Toggle (angle in)] <current>
prompt, notice that the angle value displayed in the status bar does not change. This is
because at the Specify camera location, or enter angle from XY plane, or [Toggle (angle
in)] <current> prompt, you are required to specify the vertical movement.

2. The other way to specify the angle of rotation is by entering the required angle of rotation
value at the prompt. An angle of 90-degree (default value) from the XY plane makes the
camera look at the object straight down from the top side of the object, providing you with
the top view (plan view). In this case, the line of sight is perpendicular to the XY plane of the
current UCS. An angle of negative 90-degree makes the camera look at the object straight up
from the bottom side of the object. As you move the camera toward the top side of the object,
the angle value increases. If you do not want to specify a vertical movement, press ENTER.

Once you have specified the angle from the XY plane, the next prompt displayed is given
next.

Specify camera location, or enter angle in XY plane from X axis, or [Toggle (angle from)]
<current>:

This prompt asks you for the angle of the camera in the XY plane from the X axis. This is
nothing but the horizontal (right or left) movement of the camera. You can enter the angle
value in the range of -180 to 180-degree. Moving the camera toward the right side of the
object (counterclockwise) can be achieved by increasing the angle value; moving the camera
toward the left side of the object (clockwise) can be achieved by decreasing the angle value.
You can also toggle between these two prompts using the Toggle (angle from) or Toggle
(angle in) option in the two prompts. The use of the toggle option can be illustrated as
follows.

There are two ways to enter only the angle in the XY plane from the X axis. The first is to
give a null response to the Specify camera location, or enter angle from XY plane, or
[Toggle (angle in)] <default> prompt. The other is by using the Toggle (angle in) option.
Hence, to switch from the Specify camera location, or enter angle from XY plane, or [Toggle
(angle in)] <default> prompt to the Specify camera location, or enter angle in XY plane
from X axis, or [Toggle (angle from)] <current> prompt, you will have the following
prompt sequence.

Specify camera location, or enter angle from XY plane, or [Toggle (angle in)] <default>: T
�
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Specify camera location, or enter angle in XY plane from X axis, or [Toggle (angle from)]
<current>:

In the same manner, if you want to switch from the Specify camera location, or enter angle in
XY plane from X axis, or [Toggle (angle from)] <current> prompt to the Specify camera
location, or enter angle from XY plane, or [Toggle (angle in)] <default> prompt, the following
will be the prompt sequence.

Specify camera location, or enter angle in XY plane from X axis, or [Toggle (angle from)]
<current>: T �
Specify camera location, or enter angle from XY plane, or [Toggle (angle in)] <default>:

You have gone through the basic concept of the CAmera option of the DVIEW command. Now,
you will work out some examples to apply the camera concept.

Tip
The DVIEWBLOCK is automatically displayed when you use DVIEW without selecting
objects. You can define or redefine your own substitute DVIEWBLOCK, just like any other
block using the BLOCK command. Make sure to define it to a 1X1X1 unit size so that it will
be properly scaled in the DVIEW command.

In Figure 21-44, you have four sections. The house shown can be obtained by pressing ENTER
at the Select objects or <use DVIEWBLOCK> prompt. The drawing of the house with a
window, an open door, and a chimney obtained on the screen is a block named DVIEWBLOCK.
As you use various options of the DVIEW command, the block is updated to reflect the changes.

Figure 21-44 The CAmera option of the DVIEW command

Example 3
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Once you come out of the DVIEW command, the entire drawing is regenerated, and the view
obtained depends on the view you have selected using the various options of the DVIEW command.
In this chapter, you will use this block to demonstrate the effect of various options of the DVIEW
command. However, you can make a custom block of your own. The block should be of unit size. Set
the lower left corner of the block as the origin point. The different views of the house block you see
in Figure 21-44 can be obtained with the CAmera option of the DVIEW command. First, use the
DVIEW command to get the image of the house on the screen.

Command: DVIEW �
Select objects or <use DVIEWBLOCK>: �

Now, you have the image of the house on the screen. For Figure 21-44(a) (3D view), the following
is the prompt sequence.

Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: CA �
Specify camera location, or enter angle from XY plane, or [Toggle (angle in)] <current>:
35.26 �
Specify camera location, or enter angle in XY plane from X axis, or [Toggle (angle from)]
<current>: -45 �
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: �
Regenerating model.

Once you exit the DVIEW command, the figure of the house is removed from the screen. For
Figure 21-44(b) (top view), the following is the prompt sequence.

Command: DVIEW �
Select objects or <use DVIEWBLOCK>: �
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: CA �
Specify camera location, or enter angle from XY plane, or [Toggle (angle in)] <current>:
90 �
Specify camera location, or enter angle in XY plane from X axis, or [Toggle (angle from)]
<current>: 0 �
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: �
Regenerating model.

For Figure 21-44(c) (right side view), the following is the prompt sequence.

Command: DVIEW �
Select objects or <use DVIEWBLOCK>: �
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: CA
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Specify camera location, or enter angle from XY plane, or [Toggle (angle in)] <current>:
0.00 �
Specify camera location, or enter angle in XY plane from X axis, or [Toggle (angle from)]
<current>: 0.00 �
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: �
Regenerating model.

For Figure 21-44(d) (front view), the following is the prompt sequence.

Command: DVIEW �
Select objects or <use DVIEWBLOCK>: �
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: CA �
Specify camera location, or enter angle from XY plane, or [Toggle (angle in)] <current>:
0.00 �
Specify camera location, or enter angle in XY plane from X axis, or [Toggle (angle from)]
<current>: -90.00 �
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: �
Regenerating model.

TArget Option
With the TArget option you can rotate the target point with respect to the camera. To invoke
the TArget option, enter TA at the Enter option [CAmera/ TArget/ Distance/ POints/ PAn/
Zoom/ TWist/ CLip/ Hide/ Off/ Undo] prompt. Once you have invoked this option, the
drawing is still, but you can maneuver the target point up or down or left or right about the
camera. When you move the target, the camera is stationary. The prompt sequence for the
TArget option is given next.

Command: DVIEW �
Select objects or <use DVIEWBLOCK>: �
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: TA �
Specify camera location, or enter angle from XY plane, or [Toggle (angle in)] <current>:
Specify the angle about which the target will lie above or below the camera.
Specify camera location, or enter angle in XY plane from X axis, or [Toggle (angle from)]
<current>: Specify the angle about which the target will lie left or right of the camera.
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: �

The prompt sequence does not reveal the difference between the CAmera option and the TArget
option. The difference lies in the actual angle of view. For example, if you specify an angle of
90-degree in the Specify camera location, or enter angle from XY plane, or [Toggle (angle in)]
<current> prompt of the CAmera option, your viewing direction is from the top of the object
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toward the bottom; if you specify the same angle in the same prompt for the TArget option, your
viewing direction is from the bottom of the object toward the top.

The different views of the house block in Figure 21-45 can be obtained with the TArget option
of the DVIEW command.

First, use the DVIEW command to display the image of the house on the screen.

Command: DVIEW �
Select objects or <use DVIEWBLOCK>: �

For Figure 21-45(a) (3D view), the following is the prompt sequence.

Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: TA �
Specify camera location, or enter angle from XY plane, or [Toggle (angle in)] <current>: -
35.26 �
Specify camera location, or enter angle in XY plane from X axis, or [Toggle (angle from)]
<current>: 135 �
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: �
Regenerating model.

For Figure 21-45(b) (top view), the following is the prompt sequence.

Command: DVIEW �
Select objects or <use DVIEWBLOCK>: �

Figure 21-45 The TArget option of the DVIEW command

Example 4
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Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: TA �
Specify camera location, or enter angle from XY plane, or [Toggle (angle in)] <current>: -
90.00 �
Specify camera location, or enter angle in XY plane from X axis, or [Toggle (angle from)]
<current>: 90.00 �
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: �
Regenerating model

For Figure 21-45(c) (right side view), the following is the prompt sequence.

Command: DVIEW �
Select objects or <use DVIEWBLOCK>: �
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: TA �
Specify camera location, or enter angle from XY plane, or [Toggle (angle in)] <current>:
0.00 �
Specify camera location, or enter angle in XY plane from X axis, or [Toggle (angle from)]
<current>: 180.00 �
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: �
Regenerating model

For Figure 21-45(d) (front view), the following is the prompt sequence.

Command: DVIEW �
Select objects or <use DVIEWBLOCK>: �
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: TA �
Specify camera location, or enter angle in XY plane from X axis, or [Toggle (angle from)]
<default>: 0.00 �
Specify camera location, or enter angle in XY plane from X axis, or [Toggle (angle from)]
<default>: 90.00 �
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: �
Regenerating model.

Distance Option
As mentioned before, the line obtained on joining the camera position and the target position
is known as the line of sight. The Distance option can be used to move the camera toward or
away from the target along the line of sight. Invoking the Distance option enables perspective
viewing. Since we have not used the Distance option until now, all the previous views were in
parallel projection. In perspective display, the objects nearer to the camera appear bigger
than objects that are farther away from the camera position. In other words, in perspective views
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the parallel lines meet at a vanishing point. Another noticeable difference is that the regular
coordinate system icon is replaced by the perspective icon. This icon acts as a reminder that
perspective viewing is enabled. The Distance option can be invoked by entering D at the Enter
option [CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo] prompt.
Once you invoke the Distance option, AutoCAD LT prompts you to specify the new distance
between the camera and the target.

Specify new camera-target distance <1.0000>: Enter the desired distance between the camera
and the target.

On the top side of the screen, a slider bar appears. It is marked from 0x to 16x. The current
distance is represented by the 1x mark. This is verified by the fact that the slider bar moves right
or left with respect to the 1x mark on the slider bar. As you move the slider bar toward the right,
the distance between the camera and the target increases; as you move the slider bar toward the
left, the distance between the camera and the target decreases. For example, when you move the
slider bar to the 16x mark, the distance between the camera and the target increases 16 times, or
you can say that the camera moved away from the target on the line of sight sixteen times the
previous distance. The distance between the camera and the target is dynamically displayed in
the status line. If you cannot display the entire object on the screen by moving the slider bar to
the 16x mark, enter a larger distance at the keyboard. To revert to parallel viewing, invoke the
Off option. If you want to magnify the drawing without turning the Perspective viewing on, you
can use the Zoom option.

Let Figure 21-46(a) be the default figure, in which the distance between the camera and target is
4 units, which corresponds to the 1x mark on the slider bar. You can change the distance
between the camera and target and get different views as follows.

Example 5

Figure 21-46 The  Distance option of the DVIEW command
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For Figure 21-46(b), the following is the prompt sequence.

Command: DVIEW �
Select objects or <use DVIEWBLOCK>: �
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: D �
Specify new camera-target distance <4.0000>: 2.0 �

For Figure 21-46(c), the following is the prompt sequence.

Command: DVIEW �
Select objects or <use DVIEWBLOCK>: �
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: D �
Specify new camera-target distance <4.0000>: 16.0 ��or move the pointer to the 4x mark on
slider bar.

For Figure 21-46(d), the following is the prompt sequence.

Command: DVIEW �
Select objects or <use DVIEWBLOCK>: �
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: D �
Specify new camera-target distance <4.0000>: 36.0 ��or move the pointer to the 9x mark
on slider bar.

POints Option
With the POints option, you can specify the camera and target positions (points) in X, Y, Z
coordinates. You can specify the X, Y, Z coordinates of the point by any method used to
specify points, including object snap and .X, .Y, .Z point filters. The X, Y, Z coordinate values
are with respect to the current UCS. If you use the object snap to specify the points, you must
type the name of the object snap. This option can be invoked by entering PO at the Enter
option [CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo] prompt.

Command: DVIEW �
Select objects or <use DVIEWBLOCK>: �
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: PO �

The target point needs to be specified first. A rubber-band line is drawn from the current target
position to the drawing crosshairs. This is the line of sight.

Specify target point <current>: Specify the location of the target or press ENTER.

Once you have specified the target point, you are prompted to specify the camera point. A
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Figure 21-47  The POints option of the
DVIEW command

Figure 21-48  The POints option of the
DVIEW command

rubber-band line is drawn between the target point and the drawing crosshairs. This helps you to
place the camera relative to the target.

Enter camera point <current>: Specify the location of the camera press ENTER.

The establishment of the new target point and camera point should be carried in parallel projection.
If you specify these two points while the perspective projection is active, the perspective projection
is temporarily turned off, until you specify the camera and target points. Once this is done, the
object is again displayed in perspective. If the viewing direction is changed by the new target
location and camera location, the preview image is regenerated to show the change. In Figure
21-47, the target is located at the lower corner of the house, and the camera is located at the
corner of the chimney. In Figure 21-48, the camera is located at the lower corner of the house,
and the target is located at the corner of the chimney. Both these points are marked by cross
marks.

PAn Option
The PAn option of the DVIEW command resembles the PAN command. This option lets you
shift the entire drawing with respect to the graphics display area. Just as with the PAN command,
you have to specify the pan distance and direction by specifying two points. You must use a
pointing device to specify the two points if perspective viewing is active. The prompt sequence
for this option is given next.

Command: DVIEW �
Select objects or <use DVIEWBLOCK>: �
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: PA �
Specify displacement base point: Specify the first point.
Specify second point: Specify the second point.
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Example 6

Zoom Option
The Zoom option of the DVIEW command resembles the ZOOM command. With the help of
this option, you can enlarge or reduce the drawing. This option can be invoked by entering Z at
the following prompt.

Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: Z �
Specify lens length <50.000mm>: Specify the new lens length.

Just as with the Distance option, in the Zoom option a slider bar marked from 0x to 16x is
displayed on the top side of the screen. The default position on the slider bar is 1x. Two ways
to zoom can now be specified. The first is when perspective is enabled. In this case, zooming is
defined in terms of the lens length. The 1x mark (default position) corresponds to a 50.000 mm
lens length. As you move the slider bar toward the right, the lens length increases, and as you
move the slider bar toward the left, the lens length decreases. For example, when you move the
slider bar to the 16x mark, the lens length increases sixteen times, which is 16 x 50.000 mm =
800.000 mm. You can simulate the telephoto effect by increasing the lens length; by reducing
the lens length, you can simulate the wide-angle effect. The lens length is dynamically displayed
in the status bar. If perspective is not enabled, zooming is defined in terms of the zoom scale
factor. In this case, the Zoom option resembles the ZOOM Center command, and the center
point lies at the center of the current viewport. The 1x mark (default position) corresponds to a
scale factor of 1. As you move the slider bar toward the right, the scale factor increases; as you
move the slider bar toward the left, the scale factor decreases. For example, when you move the
slider bar to the 16x mark, the scale factor increases 16 x 1 = 16 times. The scale factor is
dynamically displayed on the status line.

Command: DVIEW �
Select objects or <use DVIEWBLOCK>: Select the objects.
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: Z �
Specify zoom scale factor <1>: Specify the scale factor.

In this example, you will see the effect of the Zoom option in perspective projection. In
Figure 21-49(a), the lens length is set to 25 mm. This can be realized in the following manner.

Command: DVIEW �
Select objects or <use DVIEWBLOCK>: �
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: Z �
Specify lens length <50.000mm>: 25 �

Similarly, for Figure 21-49(b), (c), and (d), you can set lens lengths to 50 mm, 75 mm, and
125 mm, respectively.
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TWist Option
The TWist option allows you to rotate (twist) the view around the line of sight. You can also say
that the object on the screen is rotated around the center point of the screen because the display
is always adjusted so that the target point is at the center of the screen. If you use a pointing
device to specify the angle, the angle value is dynamically displayed on the status line. A
rubber-band line is drawn from the center (target point) to the drawing crosshairs, and as you
move the crosshairs with a pointing device, the object on the screen is rotated around the line of
sight. You can also enter the angle of twist from the keyboard. The angle of twist is measured in
a counterclockwise direction starting from the right side.

Command: DVIEW �
Select objects or <use DVIEWBLOCK>: �
Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: TW �
Specify view twist angle <0.00>: Specify the angle of rotation (twist).

In Figure 21-50, different twist angles have been specified. For (a) the twist angle is 0, for (b) it
is 338-degree, for (c) it is 37-degree, and for (d) it is 360-degree.

Figure 21-49 The Zoom option of the DVIEW command
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CLip Option
The CLip option can be used to clip sections of the drawing (Figure 21-51). AutoCAD LT uses
two invisible clipping planes to realize clipping. These clipping walls can be positioned anywhere
on the screen and are perpendicular to the line of sight (line between target and camera). Once
you position the clipping planes, AutoCAD LT conceals all the lines that are in front of the front
clipping plane or behind the back clipping plane. The CLip option can be used in both
parallel and perspective projections. When perspective is enabled, the front clipping plane is
automatically enabled.

Note
If you have specified a positive distance, the clipping plane is placed between the target and the
camera. If the distance you have specified is negative, the clipping plane is placed beyond the
target.

The prompt sequence for the CLip option is given next.

Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: CL �
Enter clipping option [Back/Front/Off]<Off>: B �
Specify distance from target or [ON/OFF] <current>:

Once you have specified which clipping plane you want to set (the back clipping plane in our
case), a slider bar appears on the screen. As you move the pointer toward the right side of the
slider bar, the negative distance between the target and the clipping plane increases. As you
move toward the left side of the slider bar, the positive distance between the target and the
clipping plane increases; therefore, a greater portion of the drawing is clipped. The rightmost
mark on the slider bar corresponds to a distance equal to the distance between the target and the

Figure 21-50 The TWist option of the DVIEW command
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farthermost point on the object you want to clip. After specifying the distance between one of the
clipping planes (back clipping plane in this prompt sequence), you need to invoke the CLip
option again and to specify the position of the front clipping plane in terms of the distance
between the front clipping plane and the target. As you move the slider bar toward the right, the
negative distance between the target and the front clipping plane increases. As the negative
distance increases, a greater portion of the front side of the drawing is clipped. The rightmost
mark on the slider bar corresponds to a distance equal to the distance between the target and the
back clipping plane.

Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: CL �
Enter clipping option [Back/Front/Off] <Off>: F  �
Specify distance from target or [set to Eye(camera)/ON/OFF] <1.0000>: Specify the distance
from target.

To illustrate the concepts behind clipping, let us display two objects (a sphere and a cone). Let
the distance between the two be 10 units. Draw a line between the center of the sphere and the
center of the cone. Use the POints option to position the target at the center of the sphere and
the camera at the midpoint of the line joining the two center points. In this way, you have
defined the line between the two center points as the line of sight.

Now that you have defined the target and the camera, you will see the sphere and the cone
overlapping because both of them are aligned along the line of sight. You may wonder how
you are able to see the cone, since it lies behind the camera position that is analogous to the
eye. This is because in parallel projection, the camera is not analogous to the eye, but the line of
sight is; therefore, you see everything that lies in the field of vision (determined by the Zoom
option) about the line of sight. Now, when you use the CLip option and the Front suboption to
positioned at the camera point. Now you cannot see the objects (cone in our case) that are

Figure 21-51  Using the CLip option to clip the view
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behind the camera point because the default position of the front clipping plane is at the camera
position; therefore, any object in front of the front clipping plane is clipped. Also, if you have
placed the front clipping plane behind the camera position and the perspective projection is
on, the camera position is used as the front clipping plane position.

If you change the front clipping plane position, and then at some stage you want to go back to
the default front clipping plane position, you can use the Eye option. In perspective, without
invoking the CLip option, the front clipping plane is placed at the camera position; therefore,
you are able to see only what lies in front of the camera.

In Figure 21-52a, the front clipping plane has been established at a distance of 0.50 units. The
distance between the camera and the target is 3.50 units. After invoking the CLip option, the
prompt sequence is given next.

Enter clipping option [Back/Front/Off]<Off>: F �
Specify distance from target or [set to Eye(Camera)/On/OFF] <3.5000>: 0.50 �

In Figure 21-52b, the back clipping plane has been established at a distance of 0.50 units. The
distance between the camera and the target is 3.50 units. After invoking the CLip option, the
prompt sequence is given next.

Enter clipping option [Back/Front/Off]<Off>: B �
Specify distance from target or [ON/OFF] <1.0000>: 0.50 �

You might have noticed that if you combine the clipped shape in Figure 21-52a and the clipped
shape in Figure 21-52b, you get the original shape of the house. The reason is that in the first
clipped figure, whatever lies between the camera and the front clipping plane is clipped, whereas

Example 7

Figure 21-52a The Front clipping with the DVIEW command
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in the second clipped figure, whatever lies behind the back clipping plane is clipped. Since the
distances between the clipping planes and the target, and between camera and target are identical
in both figures, then if you combine the clipped figures, you will get the original shape.

Hide Option
In most 3D drawings, some of the lines lie behind other lines or objects. Sometimes, you may
not want these hidden lines to show up on the screen, so you can use the Hide option
(Figure 21-53). This option is similar to the HIDE command. To invoke the Hide option, enter
H at the Enter option [CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/
Undo] prompt.

Figure 21-52b The Back clipping with the DVIEW command

Figure 21-53 The Hide option of the DVIEW command
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Command: SHADEMODE

Off Option
The Off option turns the perspective projection off. The prompt sequence is given next.

Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: O �

When the perspective projection is turned off, you will notice that the perspective icon is replaced
by the regular UCS icon.

Undo Option
The Undo option is similar to the UNDO command. The Undo option nullifies the result of
the previous DVIEW operation. Just as in the case of the UNDO command, you can use this
option a number of times to undo the results of multiple DVIEW operations. To invoke this
option, enter U at the following prompt.

Enter option
[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/ Undo]: U �

CREATING SHADED IMAGES
In a 3D object the HIDE command can be used to hide the hidden line in the object. By
hiding the lines, you can get a better idea about the shape of the object. To get a more
realistic image of the object, you can use the SHADE and SHADEMODE commands.

SHADE Command

As you use the SHADE command, the hidden lines of the object are removed and the shaded
image of the object is displayed. The color of the shaded image depends upon the color of the
object. The single light source used here to shade the object is assumed to be placed just over the
user’s shoulder. Any subsequent changes made in the drawing are not displayed until the SHADE
command is used again. You have to use the REGEN or ZOOM command to regenerate the
drawing and display the 3D wireframe model. Remember that you cannot use the Zoom Realtime
option if the drawing is shaded.

SHADEMODE Command

The SHADEMODE command performs a hide and then creates a flat shaded picture in the
current viewport. The shading uses a single light source that is assumed to be located just
behind the user over the shoulder. The shaded image can be edited and the UNDO command
cannot be used to undo shading. Use the REGEN or ZOOM command to regenerate the
drawing and display the 3D wireframe of the object. This command can also be invoked by
choosing Shade from the View menu. The prompts sequence is given next.

Command: SHADE
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Command: SHADEMODE �
Enter option [2D wireframe/Hidden]<current>: Enter an option.

Setting the Shading Method
You can use the SHADEDGE system variable to set the shading method. If SHADEDGE is 0,
AutoCAD LT creates a shaded image with no edges highlighted. If SHADEDGE is 1, AutoCAD LT
creates a shaded image with edges highlighted in the background color. To see the effect of these
two shading methods, you need 256 color display.

If SHADEDGE is 2, AutoCAD LT paints the surfaces of the object in the background color and
displays the visible edges in the object’s color (Figure 21-54). If SHADEDGE is 3 (default setting),
AutoCAD LT paints the faces in the object’s color and displays the edges in the background
color (Figure 21-55).

Setting Diffuse Reflection
The SHADEDIF system variable is used to control the amount of light diffused that AutoCAD LT
uses to calculate the shade for each surface. The default value of SHADEDIF is 70. It can range
from 0 to 100.

ANALYZING THE REGIONS

The MASSPROP command can be used to analyze a region. This command will
automatically calculate the mass properties of the region. When you enter this command,
AutoCAD LT will list the properties of the region.

Figure 21-54  Shading with SHADEDGE = 2,
object white, and background white

Figure 21-55  Shading with SHADEDGE = 3,
object black, and background white

Toolbar: Inquiry > Region/Mass Properties
Menu: Tools > Inquiry > Region/Mass Properties
Command: MASSPROP
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Command: MASSPROP �
Select objects: Select the region.

For Coplanar and Noncoplanar Regions. The information displayed for coplanar regions is
similar to the following.

 ----------------   REGIONS   ----------------

Area:                    46.8365
Perimeter:               28.3977
Bounding box:         X: -9.6884  --  -0.7007
                      Y: 10.3701  --  15.5813
Centroid:             X: -5.1946
                      Y: 12.9757
Moments of inertia:   X: 7991.7731
                      Y: 1579.0882
Product of inertia:  XY: -3156.9161
Radii of gyration:    X: 13.0626
                      Y: 5.8065
Principal moments and X-Y directions about centroid:
                      I: 105.9936 along [1.0000 0.0000]
                      J: 315.2792 along [0.0000 1.0000]

Write analysis to a file? [Yes/No] <N>:

If you enter Y (Yes) at this last prompt, the Create Mass and Area Properties File dialog box
is displayed as shown in Figure 21-56. All the file names of the .mpr type are listed. You can
enter the name of the file in the File name edit box. The file is automatically given the
.mpr extension.

The various terms displayed on the screen as a result of invoking the MASSPROP command
are explained next.

Area. It is the enclosed area of the region.

Perimeter.     Total length of inside and outside loops of region.

Bounding box. For regions that are coplanar with the XY plane of the current UCS, the
bounding box is defined by the diagonally opposite corners of a rectangle that encloses the
region. For regions that are not coplanar with the XY plane of the current UCS, the bounding
box is defined by the diagonally opposite corners of a 3D box that encloses the region.

Centroid. This provides the coordinates of the center of area for the selected region.



Drawing and Viewing 3D Objects    21-43

©
 C

A
D

C
IM

 T
ec

hn
ol

og
ie

s,
 U

S
A

. F
or

 e
ng

in
ee

ri
ng

 s
er

vi
ce

s,
 c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

Moments of inertia. This property provides the mass moments of inertia of a region about the
two axes. The equation used to calculate this value is given next.

area_moments_of_inertia = area_of_interest * (square of radius)

Products of inertia. The value obtained with this property helps to determine the force resulting
in the motion of the object. The equation used to calculate this value is given next.

product _of_inertia YX,XZ = mass * dist centroid_to_YZ * dist centroid_to_XZ

Radii of gyration. The equation used to calculate this value is given next.

gyration_radii = (moments_of_inertia/body_mass)1/2

Principal moments and X-Y directions about centroid. This property provides you with the
highest, lowest, and middle value for the moment of inertia about an axis passing through the
centroid of the object.

Figure 21-56 The Create Mass and Area Properties File dialog box
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MODIFYING PROPERTIES OF HIDDEN LINES
When you invoke the HIDE command, by default the hidden lines are suppressed and are not
displayed in the surface or solid models. However, with AutoCAD, you can modify the hidden
lines such that when you invoke the HIDE command, they appear as dotted lines and with a
different color. This makes it extremely easy to visualize the object. The properties of the hidden
lines can be modified using the Hidden Lines Settings dialog box. To invoke this dialog box,
right-click in the drawing area and choose Options from the shortcut menu. The Options
dialog box appears. Choose the User Preferences tab and then choose the Hidden Line
Settings button to invoke the Hidden Line Settings dialog box shown in Figure 21-57.

Obscured lines Area
The options in this area are used to set the linetype and color of the hidden lines (also called
obscured lines).

Linetype
The Linetype drop-down list is used to set the linetype for the obscured lines. You can select the
desired linetype from this drop-down list. The linetype of the hidden lines can also be modified
using the OBSCUREDLTYPE system variable. The default value of this variable is 0. As a
result, the hidden lines are suppressed when you invoke the HIDE command. You can set any
value between 0 and 11 for this system variable. Figure 21-58 shows a model with hidden linetype
changed to dashed and Figure 21-59 shows the same model with hidden lines changed to
dotted.

Color
The Color drop-down list is used to define color for the obscured lines. If you define a separate
color, the hidden lines will be displayed with that color when you invoke the HIDE command.
You can select the required color from this drop-down list. This can also be done using the
OBSCUREDCOLOR system variable. Using this variable, you can define the color that you
want to assign to the hidden lines. The default value of this variable is 257. This value corresponds

Figure 21-57 The  Hidden Line Settings dialog box
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to the ByEntity color. You can enter the number of any desired color at the sequence that will
follow when you enter this system variable. For example, if you set the value of the
OBSCUREDLTYPE variable to 2 and that of the OBSCUREDCOLOR to 1, the hidden lines
will appear in red dashed lines when you invoke the HIDE command.

Note
The linetype and color for the hidden lines defined using the previously mentioned variables are
valid only when you invoke the HIDE command. They do not work if the model is regenerated.

Face intersections Area
The options in the Face intersections area are used to display a 3D curve at the intersection of
two surfaces. These options are discussed next.

Display intersections
If the Display intersections check box is selected, a 3D curve will be displayed that will define
the intersecting portion of the 3D surfaces or solid models.

Color
The Color drop-down list is used to specify the color of the 3D curve that is displayed at the
intersection of 3D surfaces or solid models.

Halo gap percentage Area
The Halo gap percentage area is used to specify in terms of percentage the distance by which
the lines that lie behind a surface or solid model will be shortened, see Figures 21-59 and 21-60.
You can specify the distance in the edit box or using the slider.

Note
The obscured linetype in Figures 21-60 and 21-61 is changed to dashed.

Figure 21-59  Model with hidden lines changed
to dotted

Figure 21-58  Model with hidden lines changed to
dashed
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Figure 21-61  Hiding the lines with halo gap
percentage as 40

Figure 21-60  Hiding the lines with halo gap
percentage as 0

Hide precision Area
The Hide precision area is used to define the precision of the hidden lines. You can select the
Low (single) radio button to set the hide precision to single. Similarly, you can select the hide
precision to double by selecting the High (double) radio button.

Include text in HIDE operations
The Include text in HIDE operations check box is selected to hide the text that lies behind a
surface or solid model when the HIDE command is invoked. If this check box is cleared, the
text will not be hidden when you invoke the HIDE command, even if lies behind a surface or a
solid model.

Figure 21-62 shows a solid model with a text. Notice that when you invoke the HIDE command,
the text is also hidden. But as the obscured linetype is changed to dashed, the text appears in
dashed lines. Figure 21-63 shows the same model with Include text in HIDE operations check
box cleared. Notice that the text is not hidden and is displayed with continuous lines.

Figure 21-63  Text excluded while hiding the hid-
den lines

Figure 21-62  Text included while hiding the
hidden lines
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Answer the following questions and then compare your answers to those given at the end of
this chapter.

1. The DDVPOINT command is used to change the viewpoint to view the solid model. (T/F)

2. The 1x mark (default position) corresponds to the scale factor of 1. (T/F)

3. When you move the slider bar to 16x mark, the scale factor is 8 times. (T/F)

4. You can draw a 3D polyline in space using the PLINE command. (T/F)

5. The __________ and the __________ commands can be used to change the viewpoint for
viewing the models in the 3D space.

6. Changing the viewpoint moves the 3D model from its default position. (T/F)

7. The DDVPOINT command allows you to set the viewpoint with respect to __________ and
__________.

8. The various types of 3D coordinate systems are __________.

9. The line formed between the target and the camera is known as __________, or __________.

10. The __________ option allows you to shift from parallel viewing to perspective viewing.

Answer the following questions.

1. You can perform Boolean operations on the regions. (T/F)

2. The ELEV command is a transparent command. (T/F)

3. You can directly write a text with thickness. (T/F)

4. Negative value for the elevation shifts the workplane in X axis direction. (T/F)

5. Which command is used to create a three-dimensional polyline?

(a) POLYLINE (b) 3DPOLY
(c) 3DPOLYLINE (c) POLY3D

Self-Evaluation Test

Review Questions
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6. Which command is used for setting the elevation and thickness for new objects?

(a) ELEVATION (b) THICKNESS
(c) ELEV (d) THICK

7. Which command is used to suppress the hidden edges in the 3D model?

(a) SUPPRESS (b) HIDE
(c) 3DHIDE (d) EDGE

8. When you open a new drawing, you are by default in which view?

(a) SE Isometric View (b) SW Isometric View
(c) Plan View (d) Bottom View

9. Which system variable has to be modified so that the ellipse should be drawn with
thickness?

(a) ELLIPSEP (b) ELLIPSER
(c) RELLIPSE (d) PELLIPSE

10. The __________ command is used to suppress the display of the edges that lie behind the
other object.

11. To draw an ellipse with thickness you have to set the value of the __________ system
variable to __________.

12. The __________ system variable is used to define the color of the hidden lines.

13. The __________ system variable is used to define the linetype of the hidden lines

14. The mass properties of a region can be written to a file with an extension of __________.

15. You can define your own block that can be used in the DVIEW command. This block can be
defined using the __________ command.
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In these exercises, you will create the models shown in Figures 21-64 through 21-66. Assume the
missing dimensions for the models.

Hints:
Draw the wireframe models and then convert them into regions using the REGION command.
Hide them to get the display similar to the one shown in the figures.

Exercises

Exercises 4 through 6 General

Figure 21-64  Model for Exercise 4

Figure 21-65  Model for Exercise 5
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Figure 21-66  Model for Exercise 6

Problem Solving Exercise 1 General

Figure 21-67  Model for Problem Solving Exercise 1

In this you will create the computer shown in Figure 21-67. You can create the wireframe model
and then convert it into regions to get the display similar to the one shown in figure. For you
convenience, another image of computer is also shown in Figure 21-68. This figure shows all the
lines including the hidden lines that are behind the visible surface. Take the dimensions of the
computer you are working on.
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Figure 21-68  Model for Problem Solving Exercise 1

Answers to Self-Evaluation Test
1 - T, 2 - T, 3 - F, 4 - F, 5 - DDVPOINT, VPOINT, 6 - F, 7 - Angle in XY plane from X axis, Angle
from XY plane, 8 - Absolute, Relative rectangular, Relative cylindrical, and Relative spherical, 9
- line of sight, view direction, 10 - Distance
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(Customizing)

Author’s Web Sites
For Faculty : Please contact the author at stickoo@calumet.purdue.edu or
tickoo@cadcim.com to access the Web site that contains the following.

1. PowerPoint presentations, programs, and drawings used in this textbook.
2. Syllabus, chapter objectives and hints, and questions with answers for every chapter.

For Students:You can download drawing-exercises, tutorials, programs, and special topics
by accessing author’s web site at www.cadcim.com or http://technology.calumet.purdue.edu/
met/tickoo/students/students.htm.




